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In this chapter you will learn:
• How to use the payment function to calculate payments to retire a loan
• How to create a loan amortization schedule
• How to use a what-if analysis with the payment function
• How to use names in a worksheet
• How to use the present value function to calculate the proceeds of a bond
• How to create a bond amortization schedule
• How to use Excel’s what-if analysis and goal-seeking capabilities with the present
value function
• How to use Excel’s Scenario Manager
• How to integrate monthly periods into loan or bond amortization analyses

Case: What SUP, Inc.
Nathan and Meagan have been contemplating the prospect of opening several
new locations. They are somewhat strapped for cash and are interested in looking into their financing alternatives. On the one hand, they could borrow funds
from their local banker. Alternatively, they could borrow money by issuing
bonds to local investors. They are curious whether Excel could help them analyze the alternatives or at least help them determine the payments required to
pay back a loan or bond.
‘‘Can Excel perform these types of loan calculations?’’ Meagan asks.
‘‘Yes,’’ Kyle responds, ‘‘not only can Excel help you with the calculations, it
can also help you with what-if sensitivity analyses to determine interest costs,
loan payments, and balances.’’

Loan Calculations
Kyle explains that loans usually involve some constant periodic payment that
pays both interest and principal over a specified period of time. Banks usually
want to see some principal payment rather than the interest-only payments often
associated with bonds. Excel has a built-in function that calculates the payment
on a loan given three variables: interest rate, period, and loan amount. The
PMT function takes three arguments and is written ¼PMT (rate, nper, pv),
where rate is the periodic interest rate, nper is the number of periods, and pv is
the present value (usually the loan amount). Kyle suggests that you create a
107
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worksheet to calculate the annual payment necessary on a 3-year, $100,000 loan
at an interest rate of 10 percent.

To calculate a loan payment using Excel’s built-in function:
1 Start Excel and open file ch5-01. The worksheet should look like
Figure 5.1.

Figure 5.1
Loan Worksheet

2 Type 100000 in cell B4, 10 in cell B5, and 3 in cell B6.
3 Type ¼PMT(B5,B6,B4) in cell B7, and then press [Enter]. Note that
the resulting amount is a negative number. This is Excel’s way of indicating that cash must be paid out to repay the loan proceeds received.
4 Place a negative sign in front of the function PMT so that the formula
reads as follows: ¼PMT(B5,B6,B4). This has the effect of making the
payment a positive number.
5 Save your work to ch5-01_student_name (replacing student_name with
your name).
Thus, a payment of $40,211.48, when made at the end of each year for
3 years, will repay the loan and interest charges.
‘‘How much of those payments is interest and how much principal?’’ Nathan
asks.
‘‘Good question.’’ Kyle responds. ‘‘That’s why it is helpful to create a loan
amortization schedule with each worksheet.’’

Loan Amortization Schedule
Kyle explains how a loan amortization schedule answers Nathan’s question.
The schedule breaks down each payment into the components of interest and
principal. You remind Kyle that interest expense, based on the accrual accounting principal, is calculated as the balance owed multiplied by the periodic
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interest rate. The amount of payment that exceeds the interest owed is applied
to the principal and so reduces the loan amount.
‘‘I can do that,’’ you say.

To add a loan amortization schedule to your worksheet:
1 Type ¼B4 in cell E11. This places the loan amount at the beginning of
the schedule.
2 Type ¼$B$7 in cell B12. This places the loan payment in the schedule.
(This reference is absolute so that it can be replicated later.)
3 Type ¼E11*$B$5 in cell C12. This formula calculates interest expense
as the loan amount multiplied by the interest rate. (The reference to the
interest rate is absolute so that it can be replicated later.)
4 Type ¼B12–C12 in cell D12. This formula calculates the amount of the
payment that reduces the loan amount, otherwise known as principal.
5 Type ¼E11–D12 in cell E12. This formula calculates the new loan balance after the loan payment as the previous loan balance less principal
reduction.
6 Replicate formulas located at cells B12 through E12 down through row
14.
7 The resulting worksheet should look like Figure 5.2.

Figure 5.2
Loan Amortization
Schedule for a $100,000
Loan at 10%

8 Save your work.

Kyle points out that, at the end of the loan period, the balance should
(of course) be zero, which it is in the worksheet.
‘‘What is the payment if the interest rate is higher or lower?’’ Meagan asks.
‘‘Another good question,’’ Kyle comments. ‘‘That leads us into the sensitivity
features of Excel that we’ve worked on previously.’’
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What-If Analysis and the Payment Function
Kyle explains that, because you built the loan amortization worksheet with cell
references, a what-if analysis is easy. To investigate the effects of changing interest rates or different loan balances, Kyle suggests he determine the effect on
the loan payment of interest rates of 11 percent and 9 percent as well as loan
balances of $150,000 or $75,000.
Using Excel, Kyle demonstrates how these variable changes affect the loan
payment.

To perform a what-if analysis using the payment function:
1 Type 11 in cell B5, and then press [Enter]. Note the change in payment.
2 Type 9 in cell B5, and then press [Enter]. Again, note the change in
payment. Your worksheet should look like Figure 5.3.

Figure 5.3
Loan Amortization
Schedule for a $100,000
Loan at 9%

3 Type 10 in cell B5, and then press [Enter].
4 Type 150000 in cell B4, then press [Enter]. Note the change in payment.
5 Type 75000 in cell B4, then press [Enter]. Note the change in payment.
Your worksheet should look like Figure 5.4.

Figure 5.4
Loan Amortization
Schedule for a $75,000
Loan at 10%

6 Type 100000 in cell B4.
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‘‘Fascinating!’’ Meagan exclaims. ‘‘This is a great tool!’’
‘‘Yes, but these formulas get a bit confusing,’’ Nathan comments. ‘‘I have
trouble understanding what the payment function is doing with B5, B6, and B4.
Isn’t there a better way of describing the arguments to functions or what these
cell references mean?’’
Kyle decides to introduce the concept of named ranges to you, Nathan, and
Meagan. He explains that cell references can also be named for clearer analysis.

Names in a Worksheet
Excel provides a naming feature in every worksheet that allows you to define a
cell or cells with a name that can then be used elsewhere in the worksheet.
There are two steps involved in changing an existing worksheet from cell references to named references. Step 1 is defining cell names; Step 2 is applying
those names throughout the worksheet. Kyle suggests that you first name the
variables Amount, Rate, Term, and Payment and then apply those names
throughout the loan amortization worksheet.

To use names in the loan amortization worksheet:
1 Select the cell range A4 through B7.
2 Click Create from Selection from the Defined Names group of the
Formulas tab.
3 Click in the check box next to Left column as shown in Figure 5.5.
(Note: This will name the cells in B4 through B7 with the corresponding name in the left column.)

Figure 5.5
Creating Names

4 Click OK.
5 Click in cell E11.
6 Click Use in Formula from the Defined Names group on the Formulas tab.
7 Click Amount and then press [Enter]. (Note: This action only replaces the reference to B4 in cell E11 with the newly defined name
Amount.)
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8 Click in cell B12. Click Use in Formula like you did before and this
time click Payment and then press [Enter]. Then fill this new formula
down to cell B14.
9 Click in any blank cell and then click the down arrow next to Define
Name and then click Apply Names and then click OK from the
Apply Names window. (Note: This action replaces all references to
B4, B5, B6, and B7 with the respective new names of Amount, Rate,
Term, and Payment.)
10 Click in cell B7. Observe that the new argument references the
payment function: ¼PMT(Rate,Term,Amount).
11 Save your work.
Kyle explains that not all cell references will be replaced, since you defined
only four cells. However, all references to those cells will now refer to the
names instead of specific cells such as B4 and B5.
‘‘This looks much better,’’ Nathan says. ‘‘Now I can clearly see that the payment function takes three arguments: Rate, Term, and Amount.’’
Kyle further explains that these named cells can be used in other ways as
well. For example, Excel provides you with a Name Box that lists all the named
cells and ranges on the worksheet. He suggests that you explore the use of
names further.

To explore the use of named cells and ranges:
1 Click on the drop-down arrow of the Name box located next to the
formula text box to reveal the named cells on the worksheet. Then
highlight Rate but don’t click; see Figure 5.6.

Figure 5.6
Name Box
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2 Now click Rate. (Note how Excel now positions the active cell as B5,
the location of the name Rate.)
3 Save and close this file.
Once names have been created, they can be used throughout the worksheet
as you’ll see in the next section. Kyle suggests that you now explore the use of
worksheets as tools for bond calculations.

Present Value and Bonds
You recall having lots of trouble with present value and bonds while in school
and are leery of using them in a worksheet. However, Kyle calms your fears by
explaining how the use of a worksheet actually helped him better understand
bonds and the concept of present value.
‘‘Whoa now!’’ Meagan comments. ‘‘Why should I learn about present
values?’’
‘‘Present values are very helpful to an accountant and businessperson,’’ Kyle
explains. ‘‘In fact, you were using present value concepts when you computed
the loan payment above!’’
Kyle reminds you that bonds are financial instruments that usually require
constant interest payments to the bondholder and then a lump-sum payment
equal to the bond’s face value at the end of a specified term. The proceeds from
a bond’s sale, however, depend on the market interest rate at the time of sale.
Kyle explains that Excel’s present value function can compute those proceeds
based on the following variables: market interest rate, term, periodic interest
payment, and lump-sum face value payment. The present value function is written: PV(rate,nper,pmt,fv), where rate is the market rate of interest, nper is the
number of periods, pmt is the periodic interest payment, and fv is the future
value that is paid at the end of the bond term.
You recall that, if the stated rate of interest on a bond differs from the market
rate of interest, then the bond’s proceeds won’t match its face value. If the
stated rate is lower than the market rate, then buyers will pay less than the face
value, resulting in a discount; if the stated rate is higher than the market rate,
then buyers will pay more than the face value, resulting in a premium.
Kyle suggests you use Excel to calculate proceeds of a $100,000 bond paying 10 percent per year for 5 years, given an 11 percent market interest rate at
the time of the bond’s issuance.

To calculate bond proceeds:
1 Open file ch5-02. The worksheet should look like Figure 5.7.
2 Type 100000 in cell B4 to identify the bond face value.
3 Type 10 in cell B5 to identify the bond’s stated interest rate.
4 Type 11 in cell B6 to identify the market interest rate.
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Figure 5.7
Bond Worksheet

5 Type 5 in cell B7 to identify the bond term.
6 Type ¼B4*B5 in cell B8 to calculate annual interest payment.
7 Type ¼PV(B6,B7,B8,B4) in cell B9 to calculate bond proceeds.
(Don’t forget the minus sign in front of PV to make the proceeds
positive.)
8 Type ¼B9–B4 in cell B10 to calculate the bond discount or premium.
Your worksheet should look like Figure 5.8.

Figure 5.8
Calculating Bond
Proceeds

9 Name the cells located at B4 through B10.
10 Apply the names you just defined. (Hint: If you need help doing this,
review the Names in a Worksheet section of this chapter.)
11 Click on cell B9. The new formula should read as follows:
¼PV(Market_Rate,Term,Interest_Payment,Amount).
12 Save the file as ch5-02_student_name (replacing student_name with
your name).
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Next you need to create a bond amortization schedule to summarize interest
payments, interest expense, bond amortization, and remaining carrying value.

Bond Amortization Schedule
A bond amortization schedule is, in essence, a reconciliation of interest payments and bond accounting. Interest expense, usually recorded using the ‘‘effective interest’’ method, is based on the market rate of interest and the carrying
value of the debt.
Kyle suggests that you complete the bond amortization table using the named
cell ranges that you’ve already created. In addition to the effective interest formula described previously, you’ll need to compute the bond discount/premium
amortization as the difference between the interest expense recorded and the interest payment. The ending carrying value for each period will then be the previous period carrying value plus or minus the remaining discount or premium
amortization.

To create the bond amortization schedule:
1 Select cell E13.
2 Click Use in Formula from the Defined Names group of the Formulas
tab.
3 Click Discount_Premium from the drop-down list of names and then
press [Enter]. (Note: This is one way to use previously defined
names.)
4 Type ¼AmountþE13 in cell F13. Then replicate this formula down
to cell F18. This calculation represents the sum of the discount or
premium left to be amortized plus the face value of the note.
(Note: Typing a name is another way of using previously defined
names.)
5 Type ¼Interest_Payment in cell B14. Replicate this formula down to
cell B18.
6 Type ¼F13*Market_Rate in cell C14. Replicate this formula
down to cell C18. These cells will calculate interest expense as the
previous period carrying value multiplied by the market rate of
interest.
7 Type ¼B14–C14 in cell D14. Replicate this formula down to
cell D18. These cells will calculate the amortization for the period
as the amount by which interest expense differs from the interest
payment.
8 Type ¼E13–D14 in cell E14. Replicate this formula down to cell
E18. These cells will calculate the remaining amount of bond discount
or premium to be amortized in future periods.
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9 Type ¼SUM(B14:B18) in cell B19 to sum interest payments.
10 Format the cell with a top and double bottom border.
11 Replicate the formula to cell D19 to sum interest expense and
amortization.
12 Select cell B19, then click Define Name from the Defined Names
group on the Formulas tab of the Ribbon.
13 Type Total_Interest_Payments in the Name: text box and then click
OK.
14 Select cell C19, then click Define Name from the Defined Names
group on the Formulas tab of the Ribbon.
15 Type Total_Interest_Expense in the Name: text box and then click
OK. (Note: You’ll use this name later.)
16 The resulting amortization table should look like Figure 5.9.

Figure 5.9
Bond Amortization at a
Market Rate of 11%

17 Save the file.

‘‘I’ll bet we can use this schedule to do some what-if analyses like we did
with the loan amortization schedule,’’ you suggest.
‘‘Exactly!’’ Kyle responds. ‘‘Let’s see the impact of changing the effective
interest rate on bond proceeds and interest expense.’’
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What-If Analysis and Goal Seeking
Nathan is curious about the impact that different market interest rates will have
on the proceeds from a bond issuance and on the company’s interest expense.
He suggests you try interest rates of 9 percent and 12 percent.

To assess the effect of different market rates:
1 Type 9 into cell B6. Note the effect on bond proceeds and total interest
expenses, as shown in Figure 5.10.

Figure 5.10
Bond Amortization at a
Market Rate of 9%

2 Type 12 into cell B6. Note the effect on bond proceeds and total
interest expenses.

‘‘Wow, that sure is useful.’’ Nathan says. ‘‘We can use this information for
our accounting record keeping as well as for financial planning.’’
‘‘Quite true,’’ Kyle responds. ‘‘Excel also has a goal seek feature to help
determine a stated rate given needed bond proceeds. Let’s assume the company
wants to issue a 5-year, $100,000 bond when the market interest rate is 8 percent. If the company needs at least $95,000 from the proceeds, what must be
the bond’s stated rate of interest?’’
‘‘I’ll use the existing worksheet and try different stated rates to see how close
I can get to $95,000,’’ you comment.
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‘‘Not necessary,’’ Kyle explains. ‘‘We can use the existing worksheet formulas and simply use Excel’s goal seek feature. First you change the variable information, such as the market rate of interest. Then you invoke the goal seek
command, set the location of the desired value (B9), specify the desired value
(95,000), and identify the location of the variable that should be changed to
achieve the desired value (B5). In this case, that location is the cell containing
the stated interest rate.’’
‘‘I’ll try that,’’ Meagan says.

To use the goal seek feature:
1 Type 8 into cell B6. Observe the effect on bond proceeds (the old stated
rate of 10% implied payment of a bond premium).
2 Now click What-If Analysis from the Data Tools group of the Data tab
of the Ribbon.
3 Select Goal Seek from the drop-down menu.
4 Type Proceeds in the Set cell: edit box. (Alternatively, you could click
in the Set cell: edit box and then click cell B9.)
5 Type 95000 in the To value: edit box.
6 Type Stated_Rate in the By changing cell: edit box, as shown in
Figure 5.11.

Figure 5.11
Goal Seek Window

7 Click OK. The Goal Seek Status window should appear as shown in
Figure 5.12, indicating that a solution has been found.
8 Click OK in the Goal Seek Status window.
9 Save your work.
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Figure 5.12
Goal Seek Status
Window and Goal
Seek Solution

Kyle remarks that the goal seek solution indicates that a stated rate of 6.75
percent yields the $95,000 proceeds needed, given an 8 percent market rate for
a 5-year, $100,000 bond. In reality, the stated rate necessary to produce exactly
$95,000 in proceeds is slightly smaller than 6.75. The B5 cell is formatted to
show only two decimal places. If you formatted the cell to read additional decimal places it would have shown 6.74771772716582%. However, Kyle contends
that 6.75 percent is close enough!
‘‘This is very cool,’’ Nathan comments, ‘‘but I wish I could see the effects of
the different market rates on the bond proceeds in one worksheet at one time.’’
Kyle responds: ‘‘Sounds like I need to demonstrate the Scenario Manager to
you.’’

Scenario Manager
Scenarios are part of a suite of commands called what-if analysis tools. When
you use scenarios, you are performing what-if analysis. As we’ve seen, what-if
analysis is the process of changing the values in cells to see how those changes
will affect the outcome of formulas on the worksheet. The values in cells are independent variables but formulas, by their very nature, yield dependent variables. That is, the value generated by a formula is dependent on the values in
the worksheet’s cells that are specified in that formula. You can use scenarios
to create and save different sets of independent variable values and switch
between them. You can also create a scenario summary report, which combines
all the scenarios into one worksheet.
Kyle suggests you use the Scenario Manager to create a scenario describing
the effects a change in the market interest rate (an independent variable) on the
proceeds from issuing a bond (a dependent variable) and the related total interest expense (another dependent variable) over the term of the bond.
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To use the Scenario Manager:
1 Type 100000 in cell B4, 10% in cell B5, and 11% in cell B6 to
return to the original bond proposal.
2 Click What-If-Analysis from the Data Tools group of the Data tab on
the Ribbon.
3 Click Scenario Manager.
4 Click Add to add a new scenario.
5 Type 1 in the Scenario name: text box.
6 Type Market_Rate in the Changing cells: text box. Your window
should look like Figure 5.13.

Figure 5.13
Adding a Scenario

7 Click OK.
8 Type 0.12 for the Market_Rate, as shown in Figure 5.14. (Note: 0.12
represents interest at 12 percent.)

Figure 5.14
Entering Scenario
Values

9 Click OK.
10 Continue the same process by adding scenarios 2, 3, and 4, which
change the Market_Rate cell to 0.10, 0.09, and 0.08 respectively. Your
window should now look like Figure 5.15.
11 Click Summary.
12 Select the Scenario summary option button and then type Proceeds,
Total_Interest_Expense in the Result cells text box. (Note: This
action specifies the target variables affected by the change in interest
rate—namely, bond proceeds, located in cell B9, and total interest
expense, located in cell C19.) See Figure 5.16.
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Figure 5.15
Scenario Manager with
Four Scenarios

Figure 5.16
Scenario Summary
Options

13 Click OK.
14 A new worksheet should appear, entitled Scenario Summary, that
looks like Figure 5.17.

Figure 5.17
Scenario Summary

15 Save your work.

You explain to Nathan and Meagan how the Scenario Manager is just an
extension of the what-if analysis capabilities of Excel. The ability to compare
alternative outcomes based on variations in market rates should prove most
helpful in planning and future decision making.
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Monthly Periods
So far you have created annual loan and bond amortization schedules and have
determined loan payments and bond proceeds based on annual payments.
Nathan is curious how this analysis would change if you were confronted with
a monthly payment situation.
Kyle offers to help you modify your worksheets for monthly payments. He
suggests you take the previous loan workbook you created—a 3-year loan of
$75,000 with interest at 10 percent and payments due every year—and convert
it to a 3-year loan at 10 percent with 36 monthly payments. Kyle explains that
the PMT function was used to determine annual payments; converting to
monthly payments requires that the arguments in the payment function be
changed from annual to monthly. The first argument is the periodic interest rate.
The annual rate is 10 percent, so we need only divide by 12 to obtain the
monthly interest rate. The second argument is the term. Since the term is 3
years, we simply multiply 3 by 12 to obtain the number of monthly periods: 36.

To modify your worksheets from annual to monthly:
1 Open your previously saved workbook, ch5-01_student_name.
2 Change the name of Sheet1 to Annual.
3 Right-click the Annual sheet tab and then click Move or Copy.
4 Select the Create a copy check box and then select Sheet2 to insert a
copy of your worksheet before Sheet2; then click OK.
5 Change the name of Annual (2) to Monthly.
6 Type ¼PMT(Rate/12,Term*12,Amount) as the formula for cell B7.
7 Select cells A13 and A14, then fill down the column so that payment
numbers 1 through 36 show.
8 Type ¼E11*Rate/12 as the new formula in cell C12
9 Fill that formula down to cell C14.
10 Select cells B14 through E14.
11 Fill the formulas in those cells down through B47 through E47.
12 Click File and then click Print to view a print preview.
13 Click Page Setup and click the Page tab (if it is not already selected)
then choose the Fit to: option to scale the worksheet to 1 page wide
by 1 page tall.
14 Click OK and then click Print. Your printout should look like
Figure 5.18.
15 Save your work.
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Figure 5.18
Printed Monthly Loan
Amortization Worksheet

‘‘I see,’’ Nathan says. ‘‘Not only is the payment reduced, but the loan is fully
amortized after the 36th payment.’’
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‘‘Exactly,’’ responds Kyle. ‘‘Note how the interest portion of each payment
diminishes with each payment while the principal portion increases.’’
Meagan and Nathan are impressed with Excel’s robust features and functionality. You and Kyle point out that you’ve barely scratched the surface and that
more is to come.

End Note
You’ve applied some of what you learned in the first four chapters to better
understand how Excel can be used to analyze loans and bonds. In addition,
you’ve learned some new functions—conditional (IF), payment (PMT) and present value (PV)—as well as two new features, goal seeking and Scenario
Manager. In the next chapter, you’ll explore cash flow budgets.
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practice
1

Explain the difference between a loan and a bond.

2

What function is used to calculate a loan payment?

3

What arguments does the loan payment function take?

4

Why does the payment function result in a negative number?

5

What does a loan amortization schedule do?

6

Describe the formula for computing interest expense each period for a loan.

7

What function is used to calculate bond proceeds, and what arguments
does that function take?

8

Describe the formula computing interest expense each period for a bond.

9

Describe the goal seek process.

10

Describe the Scenario Manager.

5

Chapter 5 Assignments
1

Create a new What SUP Loan Amortization Schedule
Using the ch5-03 file to start your work, create a worksheet (similar to
the one created in this chapter) that calculates the required annual payment for a $945,500, 7-year loan at 4 percent and includes a loan amortization schedule. (Be sure to use names in the worksheet, as illustrated in
the chapter. You will also need to format the cells.) Save your file as
ch5-03_student_name (replacing student_name with your name).
a.

Print the newly completed worksheet in Value view, with your name
and date printed in the lower left footer and the file name in the
lower right footer.

b.

Print the worksheet from part a (above) in Formula view, with your
name and date printed in the lower left footer and the file name in
the lower right footer.

c.

Use the Scenario Manager to create a scenario using rates of 10, 9,
7, and 6 percent to calculate alternative payments. Print the resulting
summary worksheet.

d.

Use Excel’s goal seek feature to calculate the amount the company
could borrow if it could afford a payment of $100,000 per year assuming the original loan assumptions. Print the resulting worksheet in Value
view, with your name and date printed in the lower left footer and the
file name in the lower right footer.
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2

Create a new What SUP Bond Amortization Schedule
Using the ch5-04 file to start your work, create a worksheet (similar to
the one created in this chapter) that calculates the bond proceeds for a
$1,500,000, 10-year, 3 percent stated interest bond issued when the market interest rate is 2.8 percent. Include a bond amortization schedule and
use names in the worksheet, as illustrated in the chapter (You will also
need to format the cells.) Save your file as ch5-04_student_name
(replacing student_name with your name).
a.

Print the newly completed worksheet in Value view, with your name
and date printed in the lower left footer and the file name in the
lower right footer.

b.

Print the worksheet from part a (above) in Formula view, with your
name and date printed in the lower left footer and the file name in
the lower right footer.

c.

Use the Scenario Manager to create a scenario using stated rates of
2, 2.5, 3.1, and 3.5 percent to calculate alternative annual interest
payments and bond proceeds. Print the resulting summary worksheet.

d.

Use Excel’s goal seek feature to calculate the stated interest rate it
would have to pay under the original bond analysis (in part a) to
achieve bond proceeds of $1,450,000. Print the resulting worksheet
in Value view, with your name and date printed in the lower left
footer and the file name in the lower right footer.

Chapter 5 C ase P roblem 1:

KELLY’S BOUTIQUE
Kelly’s Boutique is contemplating several alternative means of financing an
expansion. One alternative is to borrow $300,000 from a local bank; another alternative is to borrow this amount from investors by issuing bonds. Both alternatives involve a 5-year debt period. Modify the workbook file ch5-05 to
compute a loan and bond analysis. Name and format cell ranges as appropriate.
Assume an initial loan rate of 3 percent, an initial bond stated rate of 3 percent,
and a market interest rate of 2.9 percent.
a.

Print the newly completed loan and bond worksheets in Value view,
with your name and date printed in the lower left footer and the file
name in the lower right footer.

b.

Print the worksheets from part a (above) in Formula view, with your
name and date printed in the lower left footer and the file name in the
lower right footer.

c.

Use the Scenario Manager to create two loan scenarios called Best
Case and Worst Case. In the Best Case, the rate would be 2.8 percent
and the loan amount would be $325,000; in the Worst Case, the
rate would be 3.2 percent and the loan amount would be $280,000.
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(Hint: You’ll need to place two cell references, separated by a comma,
in the Changing cells: text box.) The resulting comparison values
you’re trying to predict are Payment, Total Payments, and Total Interest. Print the resulting summary worksheet.
d.

Use the Scenario Manager to create two bond scenarios called Best
Case and Worst Case. In the Best Case, the market rate would be 2.5
percent and the stated rate would be 2 percent; in the Worst Case, the
market rate would be 3.2 percent and the stated rate would be 3.1 percent. (Again, you’ll need to place two cell references, separated by a
comma, in the Changing cells: text box.) The resulting comparison
values you’re trying to predict are Proceeds, Total Interest Payments,
and Total Interest Expense. Print the resulting summary worksheet.

e.

Use Excel’s goal seek feature to calculate the interest rate that the
company would have to negotiate under the original loan analysis (in
part a) to achieve a payment of $63,000. Round the interest rate to
two decimal places. Print the resulting worksheet in Value view, with
your name and date printed in the lower left footer and the file name
in the lower right footer.

f.

Use Excel’s goal seek feature to calculate the market rate necessary to
achieve bond proceeds of $310,000. Round the interest rate to two
decimal places. Print the resulting worksheet in Value view, with your
name and date printed in the lower left footer and the file name in the
lower right footer.

Chapter 5 Case Problem 2:

WINE DEPOT
Wine Depot is considering several alternative means of financing an expansion.
One alternative is to borrow $300,000 from a local bank, but another alternative
is to borrow this amount from investors by issuing bonds. Both alternatives
involve a 3-year debt period with quarterly payments. Modify the workbook
ch5-06 to compute a loan and bond analysis, naming and formatting cell ranges
as appropriate. Assume an annual loan rate of 4 percent, an annual bond stated
rate of 4 percent, and a market annual interest rate of 3.5 percent.
a.

Print the newly completed loan and bond worksheets in Value view,
with your name and date printed in the lower left footer and the file
name in the lower right footer.

b.

Print the worksheets from part a, above, in Formula view, with your
name and date printed in the lower left footer and the file name in the
lower right footer.

c.

Use the Scenario Manager to create two loan scenarios called Best
Case and Worst Case. In the Best Case, the rate would be 3 percent
and the loan amount would be $350,000; in the Worst Case, the
rate would be 5 percent and the loan amount would be $200,000.
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(Hint: You’ll need to place two cell references, separated by a comma,
in the Changing cells: text box.) The resulting comparison values
you’re trying to predict are Payment, Total Payments, and Total Interest. Print the resulting summary worksheet.
d.

Use the Scenario Manager to create two bond scenarios called Best
Case and Worst Case. In the Best Case, the market rate would be
3.75 percent and the stated rate would be 5 percent. In the Worst
Case, the market rate would be 4.5 percent and the stated rate would
be 3.25 percent. (Again, you’ll need to place two cell references, separated by a comma, in the Changing cells: text box.) The resulting
comparison values you’re trying to predict are Proceeds, Total Interest
Payments, and Total Interest Expense. Print the resulting summary
worksheet.

e.

Use Excel’s goal seek feature to calculate the interest rate the company would have to negotiate under the original loan analysis (in part
a) to achieve a quarterly payment of $26,000. Round the interest rate
to two decimal places. Print the resulting worksheet in Value view,
with your name and date printed in the lower left footer and the file
name in the lower right footer.

f.

Use Excel’s goal seek feature to calculate the market rate necessary to
achieve bond proceeds of $315,000. Round the interest rate to two
decimal places. Print the resulting worksheet in Value view, with your
name and date printed in the lower left footer and the file name in the
lower right footer.

Chapter 5 C ase P roblem 3:

SNICK’S BOARD SHOP
Snick’s Board Shop is considering several alternative means of financing an
expansion. One alternative is to borrow $400,000 from a local bank, but another
alternative is to borrow this amount from investors by issuing bonds. Both alternatives involve a 2-year debt period with monthly payments. Modify the workbook ch5–07 to compute a loan and bond analysis, naming and formatting cell
ranges as appropriate. Assume an initial loan rate of 8 percent, an initial bond
stated rate of 8 percent, and a market interest rate of 8.5 percent.
a.

Print the newly completed loan and bond worksheets in Value view,
with your name and date printed in the lower left footer and the file
name in the lower right footer.

b.

Print the worksheets from part a, above, in Formula view, with your
name and date printed in the lower left footer and the file name in the
lower right footer.

c.

Use the Scenario Manager to create two loan scenarios called Best
Case and Worst Case. In the Best Case, the rate would be 7 percent
and the loan amount would be $350,000; in the Worst Case, the rate
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would be 9 percent and the loan amount would be $450,000. (Hint:
You’ll need to place two cell references, separated by a comma, in the
Changing cells: text box.) The resulting comparison values you’re trying to predict are Payment, Total Payments, and Total Interest. Print
the resulting summary worksheet.
d.

Use the Scenario Manager to create two bond scenarios called Best
Case and Worst Case. In the Best Case, the market rate would be
7.75 percent and the stated rate would be 7 percent. In the Worst
Case, the market rate would be 8.75 percent and the stated rate would
be 8.25 percent. (Again, you’ll need to place two cell references, separated by a comma, in the Changing cells: text box.) The resulting
comparison values you’re trying to predict are Proceeds, Total Interest
Payments, and Total Interest Expense. Print the resulting summary
worksheet.

e.

Use Excel’s goal seek feature to calculate the interest rate that the
company would have to negotiate under the original loan analysis (in
part a) to achieve a monthly payment of $17,000. Round the interest
rate to two decimal places. Print the resulting worksheet in Value
view, with your name and date printed in the lower left footer and the
file name in the lower right footer.

f.

Use Excel’s goal seek feature to calculate the market rate necessary to
achieve bond proceeds of $410,000. Round the interest rate to two
decimal places. Print the resulting worksheet in Value view, with your
name and date printed in the lower left footer and the file name in the
lower right footer.

Chapter 5 Case Problem 4:

ROSEY’S ROSES
Rosey’s Roses is considering several alternative means of financing an expansion. One alternative is to borrow $600,000 from a local bank, but another alternative is to borrow this amount from investors by issuing bonds. Both
alternatives involve a 10-year debt period with annual payments. Modify the
workbook ch5–08 to compute a loan and bond analysis, naming and formatting
cell ranges as appropriate. Assume an initial loan rate of 7 percent, an initial
bond stated rate of 7 percent, and a market interest rate of 6.5 percent.
a.

Print the newly completed loan and bond worksheets in Value view,
with your name and date printed in the lower left footer and the file
name in the lower right footer.

b.

Use the Scenario Manager to create two loan scenarios called Best Case
and Worst Case. In the Best Case, the rate would be 6 percent and
the loan amount would be $550,000; in the Worst Case, the rate would
be 8 percent and the loan amount would be $650,000. The resulting
comparison values you’re trying to predict are Payment, Total Payments, and Total Interest. Print the resulting summary worksheet.
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c.

Use the Scenario Manager to create two bond scenarios called Best
Case and Worst Case. In the Best Case, the market rate would be
6 percent and the stated rate would be 6.5 percent. In the Worst Case,
the market rate would be 8.25 percent and the stated rate would
be 8 percent. The resulting comparison values you’re trying to predict
are Proceeds, Total Interest Payments, and Total Interest Expense.
Print the resulting summary worksheet.

d.

Use Excel’s goal seek feature to calculate the interest rate that the
company would have to negotiate under the original loan analysis (in
part a) to achieve a monthly payment of $80,000. Round the interest
rate to two decimal places. Print the resulting worksheet in Value
view, with your name and date printed in the lower left footer and the
file name in the lower right footer.

e.

Use Excel’s goal seek feature to calculate the market rate necessary to
achieve bond proceeds of $650,000. Round the interest rate to two
decimal places. Print the resulting worksheet in Value view, with your
name and date printed in the lower left footer and the file name in the
lower right footer.
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